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This guide is designed to help get you started using Compadre:Document™. The guide is 
divided into the following sections: 

 Getting Started (on page 7) 

 Workbench 

 AddIn Menu 

 Translation Steps 

 Building a Translation Memory 

 ComposerEditor (on page 61) 

 Document Viewer (see ʺUsing Document Viewerʺ on page 75) 

 Getting Help (on page 85) 

This chapter tells you how to use this guide. 

 

In This Chapter 

About Document................................................................................................ 2 
Contact Technical Support................................................................................ 2 
Contact Sales....................................................................................................... 3 
Typographical Conventions ............................................................................. 4 
Terminology ....................................................................................................... 5 
 
 

Chapter 1 

Welcome 
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About Document 
Document is a language translation program designed to convert Microsoft Word 
documents and PowerPoint presentations from one language to another. Intended for 
bilingual users, Document can provide an initial translation of an entire presentation as 
well as allow individual paragraph editing. Document operates on a desktop PC in 
conjunction with PowerPoint and Word. 

How does Document work? 

After loading an existing Word document or PowerPoint presentation into Document, the 
system generates translation suggestions for all text segments in the entire presentation. To 
fine‐tune translations, you can also choose to edit each segment individually to ensure 
cultural and grammatical accuracy. When you are satisfied with a translation, Document 
inserts the text into the appropriate location while retaining original formatting of text and 
graphics. 

How does Document provide translation suggestions? 

Document uses Machine Translator and Translation Memory technology to handle a large 
vocabulary of terms. Adding translations to the Translation Memory improves reliability of 
translations as they are used in repeated documents. 
 

Contact Technical Support 
Contact Customer Support if you have questions about how to use this application or if 
you are experiencing technical difficulties. 

Start with the web site. There are FAQ and Release Notes that may have your question 
answered. 

1) Web: SpeechGear support web site (http://www.speechgear.com/support.aspx) 

2) E‐mail: support@speechgear.com (mailto:support@speechgear.com) 
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Contact Sales 
To help us improve our products, we encourage you to provide us with feedback about this 
guide or the product. Please contact us with any questions or comments you may have 
regarding this product. 

SpeechGear, Inc. 
516 West Fifth Street 
Northfield, MN 55057 
E‐mail: info@speechgear.com (mailto:info@speechgear.com) 
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Typographical Conventions 
The following kinds of formatting in the text identify special information. 

Formatting Convention  Type of Information 

To . . . Step‐by‐step procedures. You can follow these 
instructions to complete a specific task. 

NOTE:  Tips or special instructions. 

Special Bold  Denotes a description or a menu option or label. 

Button 

Denotes actiKey combinations for which you must 
press and hold down one key and then press another, 
for example, CTRL+P, or ALT+F4.on. Refers to items 
you must select, such as menu options or command 
buttons. 

Emphasis 

Used to emphasize the importance of a point or for 
variable expressions such as parameters. 

or 

Identifies a dialog box, tab, or other interface item. 

CAPITALS 
Names of keys on the keyboard. for example, SHIFT, 
CTRL, or ALT. 

KEY+KEY 
Key combinations for which you must press and hold 
down one key and then press another, for example, 
CTRL+P, or ALT+F4. 
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Terminology 
Before you begin using Document, you should understand some key terms that help you 
use SpeechGear Compadre™ systems. 

Machine Translator 

The core translator of Document is its Machine Translator (MT). This is included in every 
installation and cannot be modified by the user. The MT is a software program that aims to 
provide a correct translation of the selected text. In general, an MT is useful for providing 
the meaning or gist of a phrase, but may not always produce a grammatically correct 
translation—especially with phrases that contain acronyms, idioms, and/or colloquiums. 
Because of these shortcomings, it is typically best to first rely on the Translation Memory (if 
available). 

 

 

Translation Memory 

The Translation Memory (TM) is a database (SGTM) that contains source text and 
translation pairs. As you edit your projects, you can add new translations to the TM and 
reuse them in other translation projects. When you edit subsequent documents, the TM will 
be able to recognize previously used text and make recommendations for similar 
translations. The use of TM is completely optional; however, experienced users can 
improve their result documents by building and reusing these files. 
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NOTE: Document uses a Translation Memory database. Other Compadre products may 
use a TM database. You may share SGTM domains between other Document users. 

 

Stacking Order 

When you begin translating your document, Document Workbench uses the available 
translation sources (MTs and TMs) to search for translation suggestions. You can decide the 
order in which Document searches the sources during the translation process. This is called 
the stacking order. 

 

Minimum Confidence 

The Minimum Confidence (MC) level refers to the fuzzy matching percentage between the 
input text from the document and the TM entry source text. Only translations that meet the 
selected MC level will appear as a translation suggestion. Generally, the higher the 
percentage match, the better confidence there is that the associated translation is accurate. 
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This chapter helps you set up your computer with Document Workbench. 

 

In This Chapter 

Adjusting Regional and Language Settings ................................................... 7 
Installing Document Components................................................................... 9 
Starting Document........................................................................................... 13 
 
 

Adjusting Regional and Language Settings 
To add languages and display the Language Bar for Vista 

1) Click the Start menu, and click Control Panel. 

2) Click Clock, Language, and Region. 

3) From the Regional and Language Options area, click Change Display Language. 

The Regional and Language Options window appears. 

4) From the Keyboard and Languages tab, click Change Keyboards. 

The Text Services and Input Languages window appears. 

5) Click the Language Bar tab. 

6) Select the Docked on the Taskbar option. 

7) Click the General tab. 

8) Click Add. 

9) Select the language(s) to add to the Language Bar, and click OK. 

The default language icon should appear in your desktop taskbar next to your date / 
time information. 

10) Click OK, and close the Control Panel. 

 

To add languages and display the Language Bar for XP 

1) Click the Start menu, and click Control Panel. 

2) Double‐click Regional and Language Options. 

The Regional and Language Options screen appears. 

Chapter 2 

Getting Started 
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3) On the Languages tab, under Text services and input languages, click Details. 

4) Under Preferences, click Language Bar. 

5) Select the Show the Language bar on the desktop check box. 

6) Click Add. 

7) Select the language(s) to add to the Language Bar, and click OK. 

The default language icon should appear in your desktop taskbar next to your date / 
time information. 

8) Click OK, and close the Control Panel. 

 

To type in non-English characters with the Standard Keyboard 

1) In the text input window, use the mouse to place the cursor in the English recognition 
area, and then use the keyboard to type English characters. 

English text will appear in the English text box as you type. 

2) Translate when ready. 

3) When you are ready to type in another language, change the keyboard mode to another 
language using the Language Bar. 

NOTE: The available languages in the Language Bar will vary. To add more languages, 
use the steps on the previous page (To add languages and display the Language Bar). 

Vista:    XP:   

 

To use the Digitizer Keyboard – Tablet PC Edition Only 

1) Set the keyboard mode to ʺENʺ (English). 

2) Select the onscreen digitizer keyboard from the Tablet System Tray at the bottom of the 
screen. 

3) Use the mouse to place the cursor in the English text input area, and then use the 
keyboard to type English characters. 

4) Translate when ready. 
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5) When you are ready to type in another language, change the keyboard mode to another 
language using the Language Bar. 

 

NOTE: The available languages in the Language Bar will vary. To add more languages, 
use the procedure above (To add languages to the Language Bar). 

6) Select the onscreen digitizer keyboard from the Tablet System Tray at the bottom of the 
screen. 

7) Use the mouse to place the cursor in the target language text input area, and then use 
the keyboard to type non‐English characters. 

 

To use Handwriting Recognition – Tablet PC Edition Only 

NOTE: Handwriting recognition can be used only for English text. 

1) Select the onscreen digitizer input from the Tablet System Tray at the bottom of the 
screen. 

2) Use the mouse to place the cursor in the English text input area, and then use the stylus 
to write English characters. 

Click the Insert button to place the text in the English text input area. 
 

Installing Document Components 
SpeechGear, Inc. provides you with a Compadre:Document™ setup installer package when 
you purchase the software. The installer contains: 

 .NET Framework 

 Document Workbench and Office Add‐In 

 Document Viewer 

 Compadre:ComposerEditor™ 
 

System Requirements 

Required Hardware 
 Equipment: Desktop PC 

 Processor:   

 Arabic: 2 GHz or better clock speed ‐ Ideally Dual Core 
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 Other languages: 1 GHz or better clock speed ‐ Intel Pentium 4 or Pentium M   

 Disk Space: 320 MB minimum 

 RAM:   

 Arabic: 2 GB Minimum for Iraqi; 3 GB Minimum for MSA;   

 Other languages: 1 GB Minimum 

 I/O: CD or DVD Reader ‐ depending on the source and target languages 

Required Software 
 PC Platform Operating System: Microsoft® Windows XP Professional, Windows XP 
desktop or Tablet Edition, Windows Vista 

 Microsoft Office: 2003 or 2007 

NOTE: The 5.0 release does not support Office 2003 on Windows Vista   

 .NET Framework**: 1.1 included in installation package 

NOTE: **The .NET Framework is a component of the Microsoft® Windows® operating 
system used to build and run Windows‐based applications. The installation wizard will 
automatically install this component if you do not have it installed. 

 Internet Access ‐ for initial licensing 

 Administrator privileges ‐ for installation 

 Access to Windows installation media ‐ for language support 

 

 

Installation Steps 

When you insert the CD/DVD, the Setup.exe file automatically launches the Installation 
Wizard to guide you through the installation process. Close all MS Office applications 
(including Outlook, Word, PowerPoint) before installing Document.   

To install or upgrade Compadre Document 

1) Insert your Document DC/DVD into your disc drive.   

NOTE: If you do not have the minimum system requirements, the installation wizard 
will not be able to continue. Please make sure your system meets the requirements 
listed above.   

NOTE: If you are upgrading, you must uninstall the previous version prior to installing 
this version. 
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2) Click Next. 

 
The End User License Agreement screen appears. 

3) Confirm the agreement, and click Next. 

 
The Custom Setup screen appears. 

4) Choose the Typical installation by clicking Next. 
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clicking Next., 

The Ready to install screen appears. 

5) Click Install. 

 
The installation wizard copies the files to your hard disk at the location specified. Wait 
for the Installation Complete screen to appear. 
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6) Click Finish to complete the wizard setup. 

 

 

By default, the Document Workbench launches immediately after installation. 
Document Workbench, Document Viewer and ComposerEditor icons also appear on 
your desktop to launch these programs at a later time. 

 
 

Starting Document 
After you have successfully installed the Document Workbench and Office Add‐In onto 
your computer, a Compadre:Document™ shortcut appears on your desktop and/or in your 
Start menu. 

To launch Compadre:Document™ 

1) From your desktop, double‐click the Document Workbench shortcut. 

 
If this is the first time launching Document, a License Activation screen appears. 

2) Click Activate Online, and then type your license activation code 

Wait for the Workbench to load. 

3) Open MS PowerPoint or MS Word. If the Add‐In was installed correctly, an additional 
menu item (SpeechGear Translation) will appear within your main menu. 
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NOTE: If you are unable to find the Add‐In menu, refer to page . 
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Main Form 
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Translator Menu 

 
 

Translator > Load command 

The Load command displays the Select Translation Memory Domain form which offers a 
tree control listing all of the domains to which the user has access.   
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In this tree view, the upper most level signifies the Language Pair. Below the Language 
Pair level is the User Level (Global or Private). The bottom most level is the Domain name.   

An item that is preceded by a ʺ+ʺ can be expanded by clicking on the ʺ+ʺ. An item that is 
preceded by a ʺ‐ʺ may be collapsed by clicking on the ʺ‐ʺ. Clicking on the Expand All 
button expands all the items in the tree.   

Select the name of the domain you wish to load and then press the OK button.   

If the domain that you wish to load isnʹt listed, you may create one by using the Create 
command on the Translator menu.   

 
 

Translator > Unload command 

Clicking the Unload command will unload the Translation Memory domain that is 
selected in the Translators list box, removing it from that list. This is the same command 
that may be accessed by right‐clicking on the name of a translator in the Translators list 
box.   

This command is only enabled when a translator in the Translators list box has been 
selected.   
 

Translator > Enable command 

Clicking the Enable command will enable the translator that is selected in the Translators 
list box. This is the same command that may be accessed by right‐clicking the name of a 
translator in the Translators list box.   

This command is only enabled when a translator in the Translators list box has been 
selected.   
 

Translator > Disable command 

Clicking the Disable command will disable the translator that is selected in the Translators 
list box. This is the same command that may be accessed by right‐clicking the name of a 
translator in the Translators list box.   

Disabled translators remain in the Translators list. The color of enabled translators in the 
list is blue while the color of disabled translators is gray.   

 



 

18  Document User Guide v5‐0 Userʹs Guide 
 

This command is only enabled when a translator in the Translators list box has been 
selected.   
 

Translator > Create command 

Clicking the Create command will display the Add Translation Memory Domain form. 
Use this form to create a new domain for the current language pair and User. The Domain 
Name field is required and must be unique for the current language pair and User. The 
Description is optional. If the domain will be shared, check the Global domain checkbox; 
otherwise it will be Private. The OK button will become enabled once a Domain Name has 
been entered. 

   
 

Translator > Delete command 

Clicking the Delete command will delete the Translation Memory domain that is selected 
in the Translators list box from the domain database. All of the entries for this domain will 
be deleted.   

This command is only enabled when a translator in the Translators list box has been 
selected.   
 

Translator > Launch ComposerEditor command 

Clicking the Launch ComposerEditor command will launch SpeechGearʹs ComposerEditor 
application, which is used to work with Translation Memory domains. This includes 
creating and deleting domains, importing and exporting information relative to a selected 
domain, as well as adding, editing, and removing translation entries within a domain. New 
domains will be available for use in translation as soon as they are loaded into Document 
Workbench.   

This is the same command that is run by pressing the    button.   
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Translator > Options command 

Translator > Options > Machine Translator tab 

 
 

Include Machine Translator Results dropdown 

This is used to include Machine Translator translation suggestions in the Target Text list. 
The default value is Always. The Only as fallback value should only be used to include 
Machine Translator translations when no Translation Memory translations are included in 
the Target Text list.   

 

 
 

Convert Input to Lowercase checkbox 

If this checkbox is checked, source text will be shifted to lowercase prior to acronym 
expansion (if any) and translation. If unchecked, source text will not be modified prior to 
acronym expansion and translation. The default value is unchecked.   
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Translator > Options > Translation Memory Tab 

 
 

Minimum Confidence Up ‐ Down Control 

Set the minimum confidence as a percentage that a Translation Memory translation must 
have to be included in the Target Text list. The default value is 75%.   
 

Maximum Results Up ‐ Down Control 

Set the maximum number of translation results from a Translation Memory domain that 
can be included in the Target Text list. Each loaded domain can contribute up to this 
number of suggestions to the list. The default value is 5.   
 

Source Language field 

Displays the name of the source language for translations. Press the Choose Languages 
button to select the source/target language pair that should be used for translation. 
 

Target Language field 

Displays the name of the target language for translations. Press the Choose Languages 
button to select the source/target language pair that should be used for translations.   
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Choose Languages button 

Brings up the Select Languages Pair form, which may be used to select an existing language 
pair, add a new language pair, or remove an existing language pair.   

 

Pressing the Add Language Pair button will display the Choose Languages form, which 
allows you to select the source and target languages of a new language pair.   

 

You do not need to have a Machine Translator installed to use a new translation pair, but 
the translation suggestions that will be offered will be limited to the Translation Memory 
entries in the loaded domains for the translation pair.   

Translation Memory entries for acronyms and idiomatic expressions in language X that 
should be replaced prior to translation should be placed in a Global domain named 
ʺGeneralʺ for the language pair source X / target X. For example, the entry for the expansion 
of ʺAWOLʺ to ʺAway With Out Leaveʺ should be placed in the Global domain named 
ʺGeneralʺ for the English / English language pair. 
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Change Direction button 

Press the Change Direction button to change the direction of the translation, which is 
accomplished by exchanging the source language and the target language. For example, if 
the source language is English and the target language is French, and the Change 
Direction button is pressed, the source language will become French and the target 
language English.   
 

Launch ComposerEditor button 

Press this button    to launch SpeechGearʹs ComposerEditor application, which is used 
to work with Translation Memory domains. This includes creating and deleting domains, 
importing information into and exporting out of domains, as well as adding, editing, and 
removing translation entries within a domain. New domains will be available for use in 
translation as soon as they are loaded into Document Workbench.   

The hotkey for this command is Ctrl + Alt + L.   
 

Move Translator Up button 

Press this button    to move the selected translator up in the Translators list. This 
button is located to the right of the Translators list and is enabled only when a translator 
other than the topmost translator in the list is selected.   
 

Move Translator Down button 

Press this button    to move the selected translator down in the Translators list. This 
button is located to the right of the Translators list and is enabled only when a translator 
other than the bottommost translator in the list is selected.     
 



 

  Chapter 3       Document Workbench  23
 
 

Translators List box 

The Translators List box contains a stack of translators that will be used for translation. If a 
Machine Translator is installed for the language pair that you have selected, it will 
automatically appear in the list. You may load Translation Memory domains by selecting 
the Load command in the Translators menu. Loaded domains will always be added to the 
end of the list, but you may move a translator into the position that you want it to occupy 
by selecting it and then moving it with the Move Translator Up and Move Translator 
Down buttons.   

The order of the translators in the Translators List matters because it sets the order in 
which translation suggestions appear in the Target Text List box. Not every translator will 
always have a translation suggestion to offer, but those that do will have their suggestions 
listed in the Target Text List box in the order that the translators appear in the Translators 
list.   

When using SpeechGearʹs add‐in for either MS Word or MS PowerPoint, the translation 
suggestion in the top position in Document Workbenchʹs Target Text list box will be used for 
the translation.   

We suggest placing the Machine Translator, if any, at the bottom of the Translators stack.   

Right‐clicking with the mouse when hovering over a translator in the list will display a 
menu that lists commands that are available for that translator. The menu for a Translation 
Memory domain offers two commands, but the menu for a machine translator only offers 
the option of disabling it, since it is automatically added tot he Translators list.   

Disabled translators remain in the Translators list while unloaded Translation Memory 
domains are removed from the Translators list.   

Translators that are enabled are blue and those that are disabled are gray. For example, the 
following shows that the Translation Memory is enabled while the Machine Translator is 
disabled: 
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Files dropdown 

The Files dropdown contains the names of any file that is open in Microsoft Notepad, 
Word, or PowerPoint, as well as the clipboard. Any text that was previously selected from 
the chosen open file or Clipboard will be displayed in the Source Text box.   

The translation suggestion that you wish to use may be written back to the file or to the 
Clipboard by clicking on the Write link to the right of the translation in the Target Text list. 
There may be more than one translation suggestion. Each suggested translation will be 
accompanied with a confidence indicator. You may choose whichever translation 
suggestion you would like by clicking the ʺWriteʺ link that corresponds to the suggestion.   

 
 

Source Text text box 

Text that is typed or pasted in this text box will be translated automatically. The translation 
suggestions will appear in the Target Text list box.   
 

Splitter Bar 

A splitter bar may be found between the Source Text text box and the Target Text list box.   

 

When the cursor hovers over this bar, the cursor changes into a horizontal line with up and 
down arrows. The splitter bar may then be moved up and down by dragging it with the 
mouse while holding the Select mouse button down.   

 

 
 

Target Text list box 
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The Target Text list consists of zero or more translation items, each of which was offered by 
a translator in the Translators list. Each translation item contains several pieces of 
information and two or more control links. Translation items for translation suggestions 
from Translation Memory domains offer five or six control links while those from Machine 
Translators offer two control links.   

Translation Memory translation item:   

 

Machine Translator translation item:   

 
 

Translation 

The translation appears on the left of the item and is the translation suggestion offered by 
the translator.   
 

Translation tooltip 

Hovering over the translation for a short time will cause a tooltip to be displayed that 
shows the text that was actually translated. If the Expand Acronyms option is enabled, the 
text in the tooltip may be different from the text in the Source Text text box. If different, it is 
the result of expanding acronyms to the text in the Source Text text box prior to translation. 
The Expand Acronyms control may be enabled (checked) and disabled (unchecked) in the 
Tools menu. It is disabled by default.   
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Confidence Bar 

The confidence bar is the colored rectangle above the Write link. Confidence is a measure 
of the confidence the translator has in the translation suggestion. For Translation Memory 
translation items, the color of the confidence bar indicates the domain translatorʹs 
confidence in the translation, ranging from blue (low confidence) to light green (high 
confidence). Machine Translation translations donʹt have a confidence measure and their 
confidence bars are always blue.   

Hovering over the confidence bar will display the percent confidence for Translation 
Memory translation items.   

The minimum confidence that a Translation Memory translation must have to be included 
in the Target Text list is 75% by default. This value may be changed on the Translation 
Memory tab of the Options form in the Translator menu.   

 
 

Translator 

The Translator field is to the right of the confidence bar and displays the type of translator 
(Translation Memory ʹTMʹ or Machine Translator ʹMTʹ) followed by the language pair and 
the domain name. This identifier for the translator may be longer than the space that is 
available, but hovering over the Translator field will display a tooltip containing the entire 
identifier.   
 

Write link 

Clicking the Write link for a translation item will result in the translation being sent to the 
document specified in the Files dropdown. If Clipboard is selected in the Files dropdown, 
the translation will be copied to the clipboard. If the name of a document is selected in the 
Files dropdown, the translation will replace the selected text in that document.   
 

View link (Translation Memory items only) 

Clicking the View link for a translation item will display a read‐only Edit Translation 
Memory Entry form, showing the source, target, and notes (if any) for the translation item. 
 

Notes link (Translation Memory items only) 

Clicking the Notes link for a translation item will display an Edit Translation Memory 
Entry form showing the source, target, and notes (if any) for the translation item. Changes 
made in this form will be made to the domain database once the OK button is pressed.   

A Notes link is displayed only if the Translation Memory entry contains some notes. 
Hovering over the Notes link will cause a tooltip containing the notes to be displayed.   
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Edit link (Translation Memory items only) 

Clicking the Edit link for a translation item will display an Edit Translation Memory Entry 
form showing the source, target, and notes (if any) for the translation item. Changes made 
in this form will be made to th domain database once the OK button is pressed.   
 

Delete link (Translation Memory items only) 

Clicking the Delete link for a translation item will cause the associated Translation 
Memory entry to be removed from the domain database.   
 

New link (Translation Memory items only) 

Clicking the New link for a translation item will display a New Translation Memory Entry 
form. A new Translation Memory entry will be added to the domain database once the OK 
button is pressed.   
 

Add TM Entry link (Machine Translation items only) 

Clicking the Add TM Entry link for a translation item will display a New Translation 
Memory Entry form populated with the source and target text for the translation item. A 
new Translation Memory entry will be added to the domain database once the OK button 
is pressed.   
 

Form Resizing Controls 

The Document Workbench form may be resized by grabbing the edge or corner and adjusting 
it to your liking. Both the normal and compact views of the form have a minimum height 
and width beyond which the form cannot be resized.   
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Translation Entry Menu 

Translation Entry > New Entry command 

Clicking the New Entry command displays the New Translation Memory Entry form, 
which is used to add a Translation Memory entry to the domain database.   

 
 

Domain dropdown 

This dropdown contains the names of all domains that have been loaded into Document 
Workbench and are enabled. The selected domain name is where the new Translation 
Memory entry will be added.   

If the domain name is not listed, cancel the form, load the desired domain, and run the 
New command again.   
 

Source Text box 

The original, untranslated text should be typed or pasted into this text box. The field is 
required and may contain at most 255 characters.   
 

Target Text box 

The translation of the text for the Source text box should be typed or pasted into this text 
box. This field is required, and may contain at most 255 characters.   
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Notes Text box 

Any notes that you wish to record with this translation should be typed or pasted into this 
text box. The field is optional, and may contain at most 255 characters.   
 

Add to Domain and Write to Document button 

Once both the Source and Target text boxes both contain some text, this button will be 
enabled. Press this button if you wish to add this entry to the specified domain and to write 
the translation to the document, replacing the text in the selection.   
 

Add to Domain button 

Once both the Source and Target text boxes contain some text, this button will be enabled. 
Press this button if you wish to add this entry to the specified domain but make no change 
to the document.   
 



 

30  Document User Guide v5‐0 Userʹs Guide 
 

Translation Entry > Edit Entry Command 

Clicking the Edit Entry command displays the Edit Translation Memory Entry form, 
which is used to modify an existing Translation Memory entry in the domain database or 
to add a modified copy to a different domain. This form is populated with the source, 
target, and notes of the Translation Memory entry that contributed the translation item 
that is selected in the Target Text list box. This command is enabled only when a 
Translation Memory translation item is selected in the Target Text list box.   

 

 

 
 

Domain Dropdown 

This dropdown contains the names of all domains that have been loaded into Document 
Workbench and are enabled. The selected domain name is the domain to which the new 
Translation Memory entry will be added. The domain name that is initially selected is the 
domain that contributed the translation item that is selected in the Target Text list box.   

If the domain name is not listed, cancel the form, load the desired domain and run the New 
command again.   
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Source Text Box 

This text box is populated with the source text of the translation item that is selected in the 
Target Text list box. This text can be modified. This field is required and may contain at 
most 255 characters.   
 

Target Text Box 

This text box is populated with the target text of the translation item that is selected in the 
Target Text list box. This text can be modified. This field is required and may contain at 
most 255 characters.   
 

Notes Text Box 

This text box is not populated with any text. You may enter your notes here. This field is 
optional, and may contain at most 255 characters.   
 

Add to Domain and Write to Document button 

Once both the Source and Target text boxes both contain some text, this button will be 
enabled. Press this button if you wish to add this entry to the specified domain and to write 
the translation to the document, replacing the text in the selection.   
 

Add to Domain button 

Once both the Source and Target text boxes contain some text, this button will be enabled. 
Press this button if you wish to add this entry to the specified domain but make no change 
to the document.   
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Options Menu 

Options > Compact View command 

Select this item to toggle between the Normal View and the Compact View of Document 
Workbench. The Normal View contains more controls and information than does the 
Compact View.   

The initial view is normal. This value is remembered between sessions.   

 
 

Minimize to System Tray command 

Select this option to minimize the Document Workbench application to the system tray or to 
the task bar when it is minimized. The initial value is to not minimize the application. This 
value is remembered between sessions.   
 

Stay on Top command 

Select this option to specify whether the Document Workbench application should appear on 
top of all other applications. The initial value is unchecked, meaning that it will not 
automatically stay on top of other applications. This value is remembered between 
sessions.   
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Display Fonts command 

Clicking the Display Fonts command displays the Font form, which is used to specify the 
font that will be used to display the text in both the Source and Translation text.   

 

The default font is Microsoft Sans Serif, Regular, 9 point. This value is remembered 
between sessions.   

NOTE: If the font used for translations in the Target Text list box appears too large and 
overlaps other text, you may need to adjust the font size (DPI) in Vista. The Document 
Workbench form will only display text properly if the default scale of 96 dots per inch (DPI) 
is used.   

To determine or adjust the font size, do the following: 

Warning: Changing the DPI will require a reboot of your system before it takes effect.   

1. Minimize applications so that some of the desktop is exposed.   

2. Using the secondary mouse button, click on the desktop. A menu will be displayed.   

3. Click on the Personalize command. A form will be displayed.   

4. Click on the Adjust Font Size (DPI) command that is listed on the left under Tasks. A 
form will be displayed.   
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5. To change to the Default Scale (96 DPI), select Default Scale 96 DPI and press the OK 
button.   

 

 
 

Tools Menu 

Tools > Expand Acronyms command 

Select the Expand Acronyms option to enable acronyms and idiomatic expressions to be 
expanded prior to translation. The default value is unchecked, meaning that the acronym 
expansion will not take place prior to translation. This value is remembered between 
sessions.   

Translation Memory entries for acronyms and idiomatic expressions in the source language 
will be replaced prior to translation. These expressions should be placed in a Global 
General, for the Source language pair in use. For example, the entry for the expansion of 
ʺAWOLʺ is ʺAway Without Leaveʺ, and would be placed in the Global General domain for 
the English/ English language pair.   

Once a portion of text has been replaced during acronym expansion,    further expansion 
will not take place in the replacement text.   

If acronym expansion is enabled, the source text may be modified prior to translation. To 
see the text that was actually translated, hover over the translation in any translation item 
in the Target Text list box, and a tooltip containing this text will be displayed.   
 

Tools > Choose Languages command 

Clicking the Choose Languages command will display the Select Language Pair form. This 
command may also be run by clicking on the Choose Languages button.   

The Select Languages Pair form may be used to select an existing language pair, add a new 
language pair, or remove an existing language pair.   
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Pressing the Add Language Pair button will display the Choose Languages form, which 
allows you to select the source and target languages of a new language pair.   

 

You do not need to have a Machine Translator installed to use a new translation pair. 
However, the translation suggestions that will be offered will be limited to the Translation 
Memory entries in the loaded domains.   

Translation Memory entries for acronyms and idiomatic expressions in language X that 
should be replaced prior to translation should be placed in a General domain named 
General for the language pair source X / target X.    For example, the entry for the expansion 
of AWOL to ʺAway WithOut Leaveʺ should be placed in the Global domain named 
General for the English / English language pair.   
 

Tools > Change Directions command 

Selecting the Change Direction command will change the direction of translation, which is 
accomplished by exchanging the source language and the target language. For example, if 
the source language is English, the target language is French, and the Change Direction 
command is pressed, the source language will become French and the target language 
English.   

This command may also be run by clicking on the Change Direction button.   
 

Tools > Refresh Translations command 

If, for any reason, the translation items in the Target Text list box do not automatically 
refresh when the text in the Source Text text box is changed, select the Refresh 
Translations command to refresh them.   
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Limitations 
The source, target, and notes for a Translation Memory entry must each be 255 characters 
or less in length.   
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Full and Short Menus for PowerPoint 2003 

                 
 

Commands 

Launch Document Workbench command / Current Language 
Pair Display 

The top item in each menu serves two purposes, depending on whether Document 
Workbench is running. If Document Workbench is not running, the top item is a command 
button labeled ʺLaunch Document Workbenchʺ, and clicking on this command will start 
the Document Workbench application. If Document Workbench is running, this item displays 
the source and target languages that are active in Document Workbench.   
 

Translate All command 

Translates all of the document, including most of the document components, sending the 
segments (i.e. paragraphs, sentences, words) of the text to Document Workbench for 
translation. 

This command is enabled only when a document that contains some text is open in the 
Office application.   
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Translate Slide command (PowerPoint Only) 

Translates all of selected slide(s), including most of the presentation components, sending 
the segments (i.e. paragraphs, sentences, words) of the text to Document Workbench for 
translation.   

This command is enabled only when a presentation that contains some text is open in the 
PowerPoint application. The hotkey for this command is Ctrl + Alt + I.   
 

Translate Selection command 

Translates all of the text in a selection, sending the segments (i.e. paragraphs, sentences, 
words) of the text to Document Workbench for translation.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + O.   
 

Select Next command 

Selects the next paragraph / sentence / word in the document, depending on the 
segmentation unit. To change the segmentation that is used by selection, select a different 
segmentation unit in the Segmentation group. If no text is selected, the segment that 
contains the cursor will be selected.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + N.   
 

Select Next and Translate command 

Selects the next paragraph / sentence / word in the document, depending on the 
segmentation unit, sends the selected text to Document Workbench for translation, retrieves 
the translation suggestion, and replaces the selected text with its translation. The top‐most 
translator in Document Workbenchʹs translators stack that finds a translation for the selected 
text will provide the translation that will replace the selected text. To change the 
segmentation that is used by selection, select a different segmentation unit in the 
Segmentation group. If no text is selected, the segment that contains the cursor will be 
selected.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + T, except for Word 2003, for 
which the hotkey is Ctrl + Alt + H.   
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Select Previous command 

Selects the previous paragraph / sentence / word in the document, depending on the 
segmentation unit. to change the segmentation that is used by selection, select a different 
segmentation unit in the Segmentation group. If no text is selected, the segment that 
contains the cursor will be selected.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + V.   
 

Launch ComposerEditor command 

Launches SpeechGearʹs ComposerEditor application, which is used to work with Translation 
Memory domains. This includes creating and deleting domains, as well as adding, editing, 
and removing translation entries within a domain. New domains will become available for 
use in translation as soon as they are loaded into Document Workbench.   
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Add Translation command 

A form is displayed to collect information for a new Translation Memory entry. If the 
selected text was the result of the most recent translation, that text will populate the Source 
text field, the translated text will populate the Target text field, and any notes will populate 
the Notes field. Otherwise, the selected text will populate the Source text field. The 
information in the form will be used to create a new entry in the selected domain.   

The hotkey for this command is Ctrl + Alt + A. 

 
 

Add to Domain and Write to Document button 

Updates or creates a Translation Memory entry in the selected domain using information 
from the form, then writes the target text back to the document, replacing the selection.   
 

Add to Domain button 

Updates or creates a Translation Memory entry in the selected domain using information 
from the form.   
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Edit Last Translation Command 

Displays a form containing information on the Machine Translation suggestion or the 
Translation Memory entry that was responsible for the most recent translation. Changes to 
the fields on the form will be used to create or update a Translation Memory entry in the 
selected domain and may be used to update the selection in the document. 

This command is enabled only when at least one Translation Memory has been loaded in 
Document Workbench and at least one translation has been made in the document during 
this editing session.   

The hotkey for this command is Ctrl + Alt + E.   

 

 
 

Add to Domain and Write to Document button 

Updates or creates a Translation Memory entry in the selected domain using information 
from the form, then writes the target text back to the document, replacing the selection.   
 

Add to Domain button 

Updates or creates a Translation Memory entry in the selected domain using information 
from the form.   
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Protect Selection From Translation command (Word only) 

This protects the selected text from translation. It is recommended that you individually 
select and protect each sentence or line that you donʹt want translated. Protection is 
accomplished by inserting private fields before and after the selected text. These fields can 
be viewed by toggling the ¶ button in the Paragraph group of the Home tab, which 
shows/hides paragraph marks and other hidden formatting symbols.   

This command is only available for use with Microsoft Word and will only work when 
used with Microsoft Word 2007 or Microsoft Word 2003 ‐ Professional Edition or higher.   

The hotkey for this command is Ctrl + Alt + P.   
 

Unprotect Selection from Translation command (Word Only) 

This command removes protection from the selected text, regardless of how many of the 
selections were previously protected from translation. Unprotection is accomplished by 
removing private fields before and after the selected text. These fields can be viewed by 
toggling the ¶ button in the Paragraph group of the Home tab, which shows/hides 
paragraph marks and other hidden formatting symbols.   

NOTE: This command is only available for use with Microsoft Word and will only work 
when used with Microsoft Word 2007 or Microsoft Word 2003 ‐ Professional Edition or 
higher.   

The hotkey for this command is Ctrl + Alt + U.   
 

Send Selection to Workbench command 

This command sends the selected text to Document Workbench for translation using its 
current language pair and domain stack.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + S.   
 

Select Next and Send to Workbench command 

The next segment of text (paragraph, sentence, word) is selected and sent to Document 
Workbench for translation using its current language pair and domain stack.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + W.   
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Retrieve Translation from Workbench command 

Translated text from Document Workbench is retrieved and replaces The current selection 
with the suggested translation. The top translator in the Workbenchʹs stack will be used to 
provide the translation that will replace the selected text.   

This command is enabled only when a document that contains some text is open in the 
Office application. This command will only be successful if the current selection is the same 
selection that was used when the Send Selection to Workbench command was recently run.   

The hotkey for this command is Ctrl + Alt + R.   
 

Statistics command 

This command is useful for determining the cost of a translation and is best run before the 
document is translated. In order to provide information on how many segments 
(paragraphs, sentences, words) in the document have translations in the Translation 
Memories, it is necessary to translate all unique segments. This translation process starts 
automatically and can be cancelled by pressing the Cancel button. The translation process 
is complete when the Cancel button disappears and the Close button becomes enabled.   

       

 

This command is enabled only when a document that contains some text has been opened 
in the Office application.   
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Left-Orient Selection command 

This command changes one or more paragraphs into left‐oriented text. Some languages 
(e.g. English) are written from left to right and are left‐oriented languages. Other languages 
(e.g. Arabic) are written from right to left and are right‐oriented languages. Selecting this 
command will left‐orient one or more paragraphs of the document. If no text is selected, the 
paragraph that the cursor is in will become left‐oriented. If some text is selected, any 
paragraph that is at least partially selected will become left‐oriented.   
 

Right-Orient Selection command 

This command changes one or more paragraphs into right‐oriented text. Some languages 
(e.g. English) are written from left to right and are left‐oriented languages. Other languages 
(e.g. Arabic) are written from right to left and are right‐oriented languages. Selecting this 
command will right‐orient one or more paragraphs of the document. If no text is selected, 
the paragraph that the cursor is in will become right‐oriented. If some text is selected, any 
paragraph that is at least partially selected will become right‐oriented.   
 

Short Menu command 

This command changes the user‐preferred menu to the short menu. This preference will be 
remembered between editing sessions. 
 

Full Menu command 

This command changes the user‐preferred menu to the full menu. This preference will be 
remembered between editing sessions. The full menu is the default after Document is 
installed.   
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Hotkeys for Document Add-ins 
A hotkey is a quick way of running a command using the keyboard rather than the mouse. 
All of the hotkeys for Document Office add‐ins use a three‐key combination ‐‐ hold the Ctrl 
and Alt keys down and the letter key for the command that you wish to run. The letter keys 
for commands are listed in the following table. They are shown in capital letters, but you 
should not hold down the Shift key when pressing keys for the hotkey combination. For 
example, in order to Select Next using its hotkey, hold down the Ctrl key and the Alt key 
and then tap the N key.   

Command Power 
Point  
2003 

Power 
Point 
2007 

Word 
2003 

Word 
2007 

Add Translation  A  A  A  A 

Edit Last Translation  E  E  E  E 

Launch ComposerEditor  L  L  L  L 

Protect Selection From Translation    P  P 

Retrieve Translation from 
Workbench 

R  R  R  R 

Select Next  N  N  N  N 

Select Next and Send to Workbench  W  W  W  W 

Select Next and Translate  T  T  H  T 

Select Previous  V  V  V  V 

Send Selection to Workbench  S  S  S  S 

Translate Selection  O  O  O  O 

Translate Slide  I  I    

Unprotect Slide from Translation    U  U 
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The Document add‐in adds a tab in the Office applicationʹs ribbon that is labeled 
ʹSpeechGear Translateʹ. All of the add‐inʹs functionality may be accessed through controls 
on this tab.   

SpeechGear Translate tab in the Word 2007 ribbon 

 

SpeechGear Translate tab in the PowerPoint 2007 ribbon 
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Translation group for Microsoft PowerPoint 2007 

 
 

Translation Group label 

The label at the bottom of the Translation group will read ʹTranslationʹ if Document 
Workbench is not running, but it will display the source and target languages if Document 
Workbench is running.   
 

Translate All command 

This command will translate the whole document, including most of the document 
components, sending the segments (i.e. paragraphs, sentences, words) of the text to 
Document Workbench for translation.   

This command is enabled only when a document that contains some text is open in the 
Office application.   
 

Translate Slide command (PowerPoint only) 

This command translates all of the selected slide(s), including most of the presentation 
components, sending the segments (i.e. paragraphs, sentences, words) of the text to 
Document Workbench for translation. 

This command is enabled only when a presentation that contains some text is open in the 
PowerPoint application. The hotkey for this command is Ctrl + Alt + I. 
 

Translate Selection command 

This command translates all of the text in a selection, sending the segments (i.e. 
paragraphs, sentences, words) of the text to Document Workbench for translation. 

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + O.   
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Select Next button 

This command selects the next paragraph / sentence / word in the document, depending on 
the segmentation unit. To change the segmentation, select a different segmentation unit in 
the Segmentation group. If no text is selected, the segment that contains the cursor will be 
selected.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + N. 
 

Select Next and Translate command 

This command selects the next paragraph / sentence / word in the document, depending on 
the segmentation unit, sends the selected text to Document Workbench for translation, 
retrieves the translation suggestion, and replaces the selected text with its translation. The 
top translator in the stack that finds a translation for the selected text will provide the 
translation that will replace the selected text. To change the segmentation that is used by 
selection, select a different segmentation unit in the Segmentation group. If no text is 
selected, the segment that contains the cursor will be selected.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + T, except for Word 2003, for 
which the hotkey is Ctrl + Alt + H. 
 

Select Previous command 

Selects the previous paragraph / sentence / work in the document, depending on the 
segmentation unit. To change the segmentation that is used by selection, select a different 
segmentation unit in the Segmentation group. If no text is selected, the segment that 
contains the cursor will be selected.   

This command is enabled only when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + V.   
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Protect Selection From Translation command (Word Only) 

This command protects the selected text from translation. It is recommended that you 
individually select and protect each sentence or line that you donʹt want translated. 
Protection is accomplished by inserting private fields before and after the selected text. 
These fields can be viewed by toggling the ¶ button in the paragraph group of the Home 
tab, which shows/hides paragraph marks and other hidden formatting symbols.   

NOTE: This command is only available for use with Microsoft Word and will only work 
when used with Microsoft Word 2007 or Microsoft Word 2003 ‐ Professional Edition or 
higher.   

The hotkey for this command is Ctrl + Alt + P.   
 

Unprotect Selection From Translation command (Word Only) 

This command removes the protection fields from the selected text from translation, 
regardless of how many of the selections were previously protected from translation. 
Unprotection is accomplished by removing private fields before and after the selected text. 
These fields can be viewed by toggling the ¶ button in the Paragraph group of the Home 
tab, which shows/hides paragraph marks and other hidden formatting symbols.   

This command is only available for use with Microsoft Word and will only work when 
used with Microsoft Word 2007 or Microsoft Word 2003 ‐ Professional Edition or higher.   

The hotkey for this command is Ctrl + Alt + U.   
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Statistics command 

This command is useful for determining the cost of a translation and is best run before the 
document is translated. In order to provide information on how many segments 
(paragraphs, sentences, words) in the document have translations in the Translation 
Memories that have been loaded in Document Workbench, it is necessary to translate all 
unique segments. This translation process starts automatically and can be cancelled at any 
time by pressing the Cancel button. The translation process is complete when the Cancel 
button disappears and the Close button becomes enabled.   

     

   

This command is only enabled when a document that contains some text has been opened 
in the Office application.   
 

Segmentation Group 

                               

The segmentation unit controls the amount of text that is sent to Document Workbench for 
translation, as well as the amount of text that will be selected by the Select Next, Select 
Next and Send to Workbench, and Select Previous commands.   

Paragraphs are separated by one or more carriage returns, which are inserted by pressing 
the Return key.   

Sentences are separated by end‐of‐sentence punctuation, such as a period or question mark.   
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Formatting Group 
The formatting group of controls is used to specify the font changes, if any, that should be 
applied to all text in the selection, slide, or document as it is translated. If a change in font is 
specified, even text that is not changed during translation will have its font changed.   

                           

 

   
 

Formatting - No Change 

 

Select this formatting option if the fonts of the text being translated should be left 
unchanged. If this option is chosen, the Document add‐ins for Microsoft Word will attempt 
to retain the fonts of translated text in Word documents.   
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Formatting - Different Font 

 
 

Select Font button 

Pressing this button will display the Font form.   

 

Select the font that you would like to use for all text that is processed for translation, even if 
that text is not changed during translation or is protected from translation. Press the OK 
button to record your choice. This button will be displayed only when Different Font has 
been selected.   
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Formatting - Scale Font 

 

This option allows the user to specify a scaling factor that should be applied to the sizes of 
all fonts of text that is processed for translation without changing other properties of the 
fonts. If this option is chosen, the Document add‐ins for Microsoft Word will attempt to 
retain the fonts of translated text in Word documents.   
 

Scaling Percentage Combo Box 

The scaling‐percentage combo box offers a dropdown that lists scaling percentages ranging 
from 10% to 300% in increments of 10. The user can also replace the displayed percentage 
with any positive value, either with or without a decimal place. The percent sign will 
automatically be added to the display after the user edits it.   

NOTE: The difference in length between the source text and its translation depends a great 
deal on the language pair. For example, English text is usually shorter than its Spanish 
translation, and a scaling factor of 93% appears to work well to keep translated Spanish text 
in the same space on the page as the original English text. Document Workbench keeps the 
Document add‐ins informed of the language pair and a recommended default scaling 
factor for that pair. When you first choose the Scale font formatting option during a session, 
or after the language pair or direction has changed, the appropriate default scaling factor 
for that language pair and direction will be preselected in the Scaling percentage combo 
box. This default scaling factor is only a starting point ‐ some experimentation will be 
needed to find the value that works best for your document.   
 

ComposerEditor Group 
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Launch ComposerEditor button 

Press this button    to launch SpeechGearʹs ComposerEditor application, which is used 
to work with Translation Memory domains. This includes creating and deleting domains, 
importing information into and exporting out of domains, as well as adding, editing, and 
removing translation entries within a domain. New domains will be available for use in 
translation as soon as they are loaded into Document Workbench.   

The hotkey for this command is Ctrl + Alt + L.   
 

Add Translation command 

This command displays a form to collect information for a new Translation Memory entry. 
If the selected text was the result of the most recent translation, the text that was translated 
will populate the Source text field, the selected text will populate the Target text field, and 
any notes will populate the Notes field. Otherwise, the selected text will populate the 
Source text field. The information in the form will be used to create a new entry in the 
selected domain.   

The hotkey for this command is Ctrl + Alt + A. 
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Edit Last Translation button 

Displays a form containing information on the Machine Translation suggestion or the 
Translation Memory entry that was responsible for the most recent translation. Changes to 
the fields on the form will be used to create or update a Translation Memory entry in the 
selected domain and may be used to update the selection in the document.   

This command is enabled only when at least one Translation Memory has been loaded in 
Document Workbench and at least one translation has been made in the document during 
this editing session.   

The hotkey for this command is Ctrl + Alt + E.   

 
 

Update Domain and Write to Document button 

Updates or creates a Translation Memory entry in the selected domain using information 
from the form, then writes the target text back to the document, replacing the selected text. 
 

Update Domain button 

Updates or creates a Translation Memory entry in the selected domain using information 
from the form.   
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Advanced Translation Group 
Advanced Translation group for Microsoft Word: 

 

Advanced Translation group for Microsoft PowerPoint: 

 
 

Send Selection to Workbench button 

This button sends the selected text to Document Workbench for translation using its current 
language pair and domain stack.   

This command is only enabled when a document that contains some text is open in the 
Microsoft Office application. The hotkey for this command is Ctrl + Alt + S.   
 

Select Next and Translate button 

This button selects the next paragraph / sentence / word in the document, depending on the 
segmentation unit, sends the selected text to Document Workbench for translation, retrieves 
the translation suggestion, and replaces the selected text with its translation. The top 
translator in Document Workbenchʹs domain stack will provide the translation that will 
replace the selected text. To change the segmentation that is used by this selection, select a 
different segmentation unit in the Segmentation group. If no text is selected, the segment 
that contains the cursor will be selected.   

This command is only enabled when a document that contains some text is open in the 
Office application. The hotkey for this command is Ctrl + Alt + T, except for Word 2003,   
which uses the hotkey Ctrl + Alt + H.   
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Retrieve Translation from Workbench button 

Retrieves translated text from Document Workbench and replaces the selected text with the 
suggested translation. The top translator in Workbenchʹs domain stack will provide the 
translation that will replace the selected text.   

This command is only enabled when a document that contains some text is open in the 
Microsoft Office application. This command will only be successful if the current selection is 
the same selection that was used when the Send Selection to Workbench command was 
recently run.   

The hotkey for this command is Ctrl + Alt + R.   
 

Statistics button 

This command is useful for determining the cost of a translation and is best run before the 
document is translated. In order to provide information on how many segments 
(paragraphs, sentences, words) in the document have translations in the Translation 
Memories that have been loaded in Document Workbench, it is necessary to translate all 
unique segments. This translation process starts automatically and can be cancelled at any 
time by pressing the Cancel button. The translation process is complete when the Cancel 
button disappears and the Close button becomes enabled.   

         

   

This button is only enbaled when a document that contains some text has been opened in 
the Office application.   
 



 

  Chapter 5        Document Add‐ins for Microsoft Word 2007 and PowerPoint 2007  59
 
 

Text Orientation Group 

Left-Orient Selection button 

This button changes one or more paragraphs into left‐oriented text. Some languages (e.g. 
English) are written from left to right and are left‐oriented languages. Other languages (e.g. 
Arabic) are written from right to left and are right‐oriented languages. Selecting this 
command will left‐orient one or more paragraphs of the document. If no text is selected, the 
paragraph that the cursor is in will become left‐oriented. if some text is selected, any 
paragraph that is at least partially selected will become left‐oriented.   
 

Right-Orient Selection button 

This button changes one or more paragraphs into right‐oriented text. Some languages (e.g. 
English) are written from left to right and are left‐oriented languages. Other languages (e.g. 
Arabic) are written from right to left and are right‐oriented languages. Selecting this 
command will right‐orient one or more paragraphs of the document. If no text is selected, 
the paragraph that the cursor is in will become right‐oriented. If some text is selected, any 
paragraph that is at least partially selected will become right‐oriented.   
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When you want to edit or create a Translation Memory Domain to be used in the 
Document add‐ins, use the Composer Translation Memory database features in 
ComposerEditor. This tool allows you to customize translation capabilities for individual 
or multi‐user environments. 

A Composer database supports multiple Language Pairs. Within each Language Pair, you 
can add multiple Domains.   

The default translator in Document Workbench is a software program called a Machine 
Translator (MT). The MT is designed to give translations that represent the gist or general 
meaning of a source phrase but those translations might not be grammatically correct. The 
purpose of a Composer Domain is to keep exact translations of often‐used phrases. 
Therefore, if you know the grammatically correct translation of a phrase that you use 
frequently, you can enter both the source and target phrases into a Composer Domain. 
Document Workbench will use the translation from the Composer Domain instead of the one 
generated by the Machine Translator. 

Domains can be either Global, shared by all machine users, or Private, available only to the 
user thatʹs currently logged in. You can select a specific Domain on the Composer tab of the 
Configure screen.    By default, Document Workbench will query the selected Domain first, 
and then query the other Global Domains to attempt to find the closest match for a specific 
translation. 

This section will walk you through the process of using ComposerEditor to select a 
Language Pair, create or edit a new Domain, and add, edit or delete translations within a 
Domain. At the end of this chapter, you will also find instructions for loading the new 
Domain into the Document Workbench application. 
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ComposerEditor 
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Main Window 
ComposerEditorʹs Main window contains the following features: 

 

 
 

File menu 

Contains all Composer Domain functions: 

 New ( ): Creates a new Composer Domain. 

 Open... (Ctrl + O  ): Opens an existing Domain in the current database. 

 Close: Closes the current Domain.   

 Close All: Closes all open Domain windows. 

 Recent Documents: Lists the last Domains opened during the current session. 
Choosing a Domain from the Recent Documents list saves loading time. 

 Exit (ALT + F4): Safely closes the ComposerEditor program. 

 
 

Edit menu 

Contains all text edit options: 

 Undo (Ctrl + Z  ): Removes the last editing operation. 

 Redo (Ctrl + Y  ): Redoes the last editing operation. 

 Cut (Ctrl + X  ): Cuts the current selection of text. 

 Copy (Ctrl + C  ): Copies the current selection of text. 

 Paste (Ctrl + V  ): Pastes the last selection of text. 

 Delete (Del): Deletes the current entry in the Domain. 
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Translation Memory menu 

Contains all Domain editing options: 

 New Entry...: Adds a new entry to the Domain 

 Edit Entry...: Opens the Edit Entry dialog box. 

 Delete Entry: Deletes a selected entry. 

 
 

Tools menu 

For more information about Import and Export see Importing and Exporting Composer 
Domains (on page 68). 

 Import...: Provides import functionality; allows you to choose a source file, in TMX or 
Tab Delimited text format, and merge translations from the file with the selected target 
Domain. 

 Export...: Opens a dialog box allowing you to save the active Domain into a tab 
delimited text (.txt) file.   

 
 

Window menu 

Contains window display options: 

 Cascade: Stacks all open Domain windows in a diagonal order. 

 Tile Horizontally: Stacks all open Domain windows top‐to‐bottom. 

 Tile Vertically: Stacks all open Domain windows side‐by‐side. 

 Minimize All: Minimizes all open Domain windows; the main window becomes the 
active window. 

 Maximize All: Maximizes all open Domain windows. 
 

Help menu 

Contains the ComposerEditor About and Help files. 
 

Creating a New Composer Domain 
To connect to a Composer Database 

1) Start ComposerEditor. (Click Start > All Programs > SpeechGear > ComposerEditor.) 

The ComposerEditor Start window appears. 
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2) In the Start dialog, select SpeechGear Translation Memory. 

3) Click on the New or Open button   

The Edit window appears. 

All Global and Private Composer Domains which are available to the logged in user 
will be listed in the Domain window. 

 

To add a Language Pair to the Database 

1) Connect to your Composer database. 

The Edit window appears. 

 
2) Click Add Language Pair. 

The Select Language Pair window appears. 

 
3) Select the Source and Target languages to use in the new Language Pair, and then click 

OK. 

A confirmation window appears. 
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4) Click Yes to create the new Language Pair in the connected database. 

The Language Pair is added to the list with a default (Global)General Domain. 

NOTE: You may have to scroll to find the Language Pair in the list. 

 

To Add a Domain to a Language Pair 

1) Connect to your Composer database. 

 
2) Select the Language Pair you want to add a Domain to. 

By default, ComposerEditor will create a Private Domain. If you want to add a Global 
Domain then expand the Language Pair and select the Global User under the 
Language Pair 

3) Click Add Domain To User. 

NOTE: If you have previously removed the Global\General domain you will be asked 
here if you’d like to create a new one. 

The Add Domain Name window appears. 
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4) Enter a name and a description for the Domain, and then click OK. 

A confirmation window appears. 

5) Click Yes to create the new Domain. 

The Domain is added to the selected Language Pair. 

 

 

To remove a Domain 

1) Connect to your Composer database. 

2) Right‐click a Domain name, and then click Remove Domain. 

A confirmation window appears. 

3) Click Yes. 

NOTE: If the Domain was successfully deleted, you will no longer see it in the database 
list. 

 

To remove a Language Pair 

1) Connect to your Composer database. 

2) Right‐click a Language Pair name, and then click Remove Language. 

A confirmation window appears. 

3) Click Yes. 

The selected language and all related Domains will be removed from the database list. 
However, if any entries were added by another user (besides the Global and current 
user), the delete operation will abort.   

 



 

  Chapter 6       ComposerEditor  67
 
 

Opening a Composer Domain 
To open a Composer Domain 

1) Launch ComposerEditor and open SpeechGear Translation Memory   

The Edit window will appear 

 
2) Click the ʺ+ʺ next to the Language Pair to expose the users Global and Private. 

Select the Domain that you want to open. 

3) Click on the ʺ+ʺ next to either the Global or Private user to expose the domains within 
each.   

The selected Domain will open in a new window. 
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Importing and Exporting Composer Domains 
ComposerEditor allows you to import translations from a file into a Composer Domain or 
export translations from a Domain into a file. 

Files to be imported from must be in Translation Memory eXchange (TMX) format or tab 
delimited text files. TMX is a file format based on XML that is a standard of the 
Localization Industry Standards Association (LISA). Exporting data will result in the 
creation of a tab delimited text file.   

NOTE: Importing of a file cannot be undone. 

To import into a Composer database Domain 

1) Create a TMX file or an existing tab delimited text file that has the translations you 
want to import. 

2) Create a new Domain or open an existing Domain into which to import the terms. 

3) From the ComposerEditor Main window, click Tools > Import.... 

The Import Translation Memory window appears. 

 
4) Select the file that you want to import. 

Click Open. 
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To export a Composer Domain 

1) Open a Composer Domain. 

2) From the Tools menu, click Export. 

3) Enter a name for the new file, and then click OK. 

The file is exported into a new tab delimited text (.txt) file.   
 

Editing Composer Domains 
ComposerEditor uses right‐click commands to display all editing menus. When working 
with Composer Domains, you have the following edit commands: 

 New Record 

 Edit Record 

 Delete Record 

 Save a Domain 

To Add a New Record 

1) Open the Domain you want to edit. 

2) Right‐click anywhere in the Domain window, and then click New Record. 
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The New Domain Entry window appears. 

 
3) Enter the source text, target, and notes. 

4) Click OK. 

The record is added in alphabetical order to the Domain. 

 

 

To Edit a Record 

1) Open the Domain you want to edit. 

2) Double‐Click on the record you want to edit   

Or 

Right‐click on the record you want to edit, and then select Edit Record. 

The Edit Domain Entry window appears. 

3) Edit the source text, target, and notes. 

4) Click OK. 
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To Delete a Record 

When you delete a record, it is permanently removed from the Domain. If you are working 
in a Global Domain in a multi‐user environment, deleting a record will remove it for all 
users who are working with the Global Domain. 

1) Open the Domain you want to edit. 

2) Right‐click on the record you want to delete, and then click Delete Record. 

ComposerEditor removes the record from the list.   

Note: No confirmation box will appear but there is an Undo command under the Edit 
menu. 

 

To Save a Domain 

When working with Composer Domains connected to a shared database, changes will 
automatically be written to the database as you work. If you make an error during editing, 
you can undo the last editing operation from the Edit > Undo menu. 

When you are finished editing entries, close the Domain window to close the connection to 
the database. 
 



 

72  Document User Guide v5‐0 Userʹs Guide 
 

Acronym Expansion 
Acronym Expansion is a feature of Document Workbench that assists in getting the correct 
translation of acronyms, idioms, abbreviations and technical phrases. For example, if you 
dictated ʺWeʹre like two peas in a pod.ʺ into the English recognition area on the Translate 
screen and clicked the Translate button, the Target text might be talking about vegetables. 

In order to get the correct translation of an idiom, Document Workbench has a mechanism to 
substitute the idiom with another phrase in the same language that means the same but 
uses a more literal phrase. Therefore, the literal phrase can be translated instead of the 
words of the idiom. 

For example: 

 ʺpet projectʺ becomes ʺfavorite projectʺ 

 ʺWeʹre like two peas in a pod.ʺ becomes ʺWeʹre very similar.ʺ 

 ʺWhen pigs flyʺ becomes ʺNeverʺ 

This can be very helpful if you are using Document Workbench to communicate for your job 
and your industry regularly uses abbreviations. You can see that itʹs important to create 
your own list because different industries may use the same acronym for different terms. 

 ʺAMTʺ becomes ʺAlternative Minimum Taxʺ 

 ʺNSFʺ becomes ʺNot Sufficient Fundsʺ 

 ʺPITIʺ becomes ʺPrinciple, Interest, Taxes and Insuranceʺ 

 

This feature is enabled by checking the box labeled ʺExpand Acronymsʺ on the Tools menu 
on the Workbench main menu bar. See User Options 

You create this list of idioms and literal phrases in ComposerEditor by using the 
<language> to <language>\General Composer Domain.   

Note: This feature can be used for any language, for example Spanish to Spanish, but only 
the General Domain is currently supported. 

To Add or Edit entries in Acronym Expansion 

1) In ComposerEditor, open the English to English\General Domain. 
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2) Then add or edit terms that the English speakers might use in conversation. 
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If the Acronym Expansion capability is enabled in Document Workbench, every time you 
click the Translate button on the Translate screen, the text that is in the English recognition 
area gets compared with each of the Source entries in the English to English\General 
Domain. If an exact match is found, that phrase is replaced with the Target phrase before the 
English text is translated.   

Therefore, you will still see the Source phrase in the English recognition area on the 
Translate screen, but the text that is translated will contain the Target phrase from the 
Domain. If logging is enabled, the translated text with included expansion will be saved to 
the log. 

To reiterate, even though the examples are in English, this feature is available in other 
languages, too. 

Note: Acronym Expansion Segmentation is independent of Translation Segmentation. It 
checks for matches in this order: 

1.    Full sentence matches 

2.    2‐word matches, in any segments where full sentence matches were not found 

3.    1‐word matches, in any segments that were not expanded by full sentence or 2‐word 
matches 
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This chapter introduces you to Document Viewer. Document Viewer is a supporting slide 
show application that allows you to present multiple PowerPoint presentations at the same 
time to a multi‐lingual audience. 

After using Document to translate your original PowerPoint presentation, load Document 
Viewer with up to four presentations—Each with the same content (number of slides) but 
different languages. Document Viewer allows you to view a presentation in one of two 
modes: two‐pane or four‐pane. The slides in each pane remain synchronized as you 
advance through the presentation. 

 

In This Chapter 

Opening Document Viewer............................................................................ 75 
Loading Presentations..................................................................................... 77 
Changing the Viewing Mode ......................................................................... 78 
Resizing the Presentation................................................................................ 79 
Running the Slideshow ................................................................................... 83 
 
 

Opening Document Viewer 
To open Document Viewer 

1) Double‐click the Document Viewer shortcut on your desktop. 

NOTE: You can also launch the Viewer from the Start menu (Start > Programs > 
SpeechGear > Viewer). 

Chapter 7 

Using Document Viewer 
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The Viewer opens. 

 
2) Resize the viewer as needed by dragging the sides of the window or the borders of the 

pane divider. 
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Loading Presentations 
Document Viewer allows you to load from one to four PowerPoint presentations. Document 
Viewer is designed to show up to four presentations with the same content (number of 
slides), but written in different languages. Loading presentations with varying number of 
slides is not recommended. 

To load a presentation 

1) Choose the pane in which you want to load your first presentation. 

2) Left‐click anywhere in the pane. 

A Select Presentation File window appears. 

3) Browse through your folders to locate the PowerPoint presentation you want to load, 
and double‐click the file. 

 
Document Viewer loads the presentation into the selected pane. 

 
4) Repeat steps 1‐3 for each presentation you want to load (up to 4 total). 
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NOTE: Click File > New to clear the viewer and start over. 

 
 

Changing the Viewing Mode 
Document Viewer has two viewing modes: Two Presentations and Four Presentations. 

To select Two Presentations mode 

From the main menu, click View > Two Presentations. 

The window panes adjust accordingly, and the panes on the bottom left and right will 
not appear in the Viewer. 

 

To select Four Presentations mode 

From the main menu, click View > Four Presentations. 
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The window panes adjust accordingly to show all four panes in the Viewer. 

 

 
 

Resizing the Presentation 

Move Columns Together 

The Move Columns Together view option allows you to force the top and bottom vertical 
pane borders to resize using the same width when viewing in Four Presentation mode. 

To move columns together 

1) From the main menu, click View > Move Columns Together. 

2) Using the cursor, hover your mouse over the pane divider. 
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The panes in the same column synchronize when the dimensions are resized. 

 

 

Maintain Aspect Ratio 

The Maintain Aspect Ratio view option allows you to maintain each slideʹs proportions 
while resizing the viewing panes. Without the Maintain Aspect Ratio option selected, 
horizontal and vertical dimensions remains independent of each other during resizing. 

To maintain aspect ratio 

1) From the main menu, click View > Maintain Aspect Ratio. 
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The divider color is darkened and the window panes adjust accordingly. 

 

 

Lock Windows Evenly 

The Lock Windows Evenly view option allows you to maintain the proportions of each 
pane while resizing the entire window. Without the Lock Windows Evenly option 
selected, horizontal and vertical borders may be cropped during resizing. 

To lock windows evenly 

1) From the main menu, click View > Lock Windows Evenly. 
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The percentages of the panes are maintained as you resize the window. 

 

 

Hide the Title Bar and Main Menu 

The F12 option is a shortcut command that allows you to hide the title bar and main menu 
to increase the viewing area. 

To hide the title bar and main menu 

1) From your keyboard, press the F12 key. 
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The title bar and main menu disappear. 

 
2) Press the F12 key again to return the title bar and main menu. 

 
 

Running the Slideshow 
You can use your mouse or your keyboard to navigate through your slides. The slides in 
each pane remain synchronized as you advance or backtrack through the presentation. 

 
 

Using Your Keyboard 

Document Viewer has the following keyboard support: 

 Display the next slide: right arrow or down arrow 

 Display the previous slide: left arrow or up arrow 

 Display the first slide: Home key 

 Display the last slide: End key 
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Using Your Mouse 

Document Viewer has the following mouse support: 

 Display the next slide: left click 

 Display the previous slide: right click 

 Arrow buttons: click the arrow button (forward or backward) that appears when you 
hover your mouse over a pane. 
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This chapter provides some trouble‐shooting tips and shows you where to find additional 
help. 

 

In This Chapter 

Document Help ................................................................................................ 85 
Troubleshooting ............................................................................................... 86 
 
 

Document Help 
If you experience difficulty using Document, you can find the answers to your questions 
regarding the program usage by using the documentation provided with your licensed 
copy of Document. 

To use Document HTML Help 

1) From the main window, choose Help > Contents (or F1 on your keyboard). 

The HTML Help file opens with the most recently viewed tab. 

2) Find the information you need by: 

 Using the Contents tab. Read about finding the information you need in this Guide. 

 Using the Index tab. Find topics containing terms that have been indexed. 

 Using the Search tab. Find all occurrences of a word, no matter how trivial. 

NOTE: If your Regional and Language Options settings are not set to English (United 
States), the Document HTML Help will not load. 

 
 

Getting help with PowerPoint and Word 

If you experience difficulty using PowerPoint or Word functionality, you can find the 
answers to your questions by using the documentation provided with your licensed copy 
of Microsoft Office. 

To use PowerPoint or Word Help 

1) From the Main menu, click Help > Microsoft [PowerPoint] / [Word] Help (or press F1). 

Chapter 8 

Getting Help 
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2) Find the information you need by using the provided Search box or by viewing the 
Table of Contents. 

 
 

Troubleshooting 

Why can't I see the Document Add-In Menu? 

Make sure you have Add‐Ins enabled from your Office application (PowerPoint or Word). 

To enable Add-Ins in MS Office for Windows XP 

1) Open the Office application that you will use to translate your documents. 

2) From the Tools menu, click Macro > Security. 

The Security window appears. 

3) From the Trusted Sources tab, select the check box next to Trust all installed add‐ins 
and templates. 

4) Click OK. 

 

 
 

The translation suggestions aren't showing in the right 
characters. 

Make sure your system regional and language options are enabled to support non‐English 
characters. If your system is not equipped to support non‐English languages, you will not 
be able to view or type in languages other than English. 

See Adjusting Regional and Language Settings (on page ) for help. 
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